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Synergy Lathe

Introductions:

Welcome to Weber System’s Synergy Cad Cam Turning SoétvSynergy Lathe combines the world’s
most powerful cad cam automation tool with a specidlingerface aimed at the turning professional.

About this Guide

The Synergy Lathe handbook contains detailed informabontaNeber Systems’ Synergy Lathe tools and
commands. We have designed this handbook to be used asydagvesference tool in your work with
Synergy Lathe.

This guide assumes you have a working knowledge of your comgndet's operating conventions,
including how to use a mouse and standard menus and commands.

Conventions Used in this Handbook

Mouse Notation
Click Press and release the primary mouse buttormBet people, this will be the left-button.

Right-Click Press and release the secondary mouse buitienis usually the button furthest to the right
on the top of the mouse.

Middle-Click  Press and release the middle mouse button.
Double-Click  Some what rapidly, press and releasentiese button twice.

Drag Move the mouse as you press and hold the mouse button.

Text Notation

<Space> (Or any other keystroke...) Press the kegdtedl between the <> symbols. In this case, you
would press the spacebar. Any instructions that reqotiaion of non-printing keystrokes
will be set off by <> symbols. For example: <Esc>, <Ent or <Backspace>

<Shift> + <R> (Or any other keystroke combinatiorSometimes it is necessary to press two keys at once.
This will be represented by two keystrokes joined by a @lusign. This notation means
that you should press the <Shift> and <R> keys at tine gime.

<Shift>, <R> (Or any other keystroke combinatigrA.comma will separate keystrokes that should be
pressed in sequence. This notation means that you shoudo<@fedt>, release it, and then

press <R>.

<Shift>+Click Press and hold the Shift (or any otkeystroke) while you press and release the mouse
button.

> The—-> symbol indicates a chain of menus that you will naviggtelicking. For example,

you begin shutting the system down by clicking FiteExit from the main menu. This
notation means that your should click the word File @ntiain menu and then click Exit
from the file drop down menu.

Menu Notation

Drop Down A drop down menu is the kind of menu that appears ued#hran area after you click it.
The majority of Synergy’s menus are drop down menus.

Pop Up Menu A pop up menu is just like a drop down menu, except that ieappéhen you click in a
certain area or in a certain way. For example, rigbkiolg on an icon on the Windows NT
desktop will bring up a pop up menu.

Synergy Training 5 Weber Systems, Inc.
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Synergy’s File Structure

Synergy stores all of its necessary files in regimediettory structure.

ARCHIVE
This is the default location for the Synergy's storAgehive.

WEBDEF
This directory contains interface files that work imgmction with the guidef files.

UTIL

Tools and materials data and plotter configurati@sfgo in this directory.
USER DATA

This directory stores miscellaneous information andlanxidata.
TMP

This is the temporary directory used by the system.

POST_FORMATS
Common post processors are stored in this directory.

HTTP
This directory contains all of the Netscape-help exdéteseand data.
GUIDEF
This directory contains customizable Graphic Usenfate (GUI) definition scripts.
ETC
Output files that get copied to the bin directory areestan this directory.
DATABASE
The Database directory contains strategies and meassggeby the system.
CONTRIB
This directory acts as a Depository for customizedpasat is for unsupported material that isn’t updated.
BITMAPS
This directory contains bitmaps for the interfacese plttures and backgrounds that you see on the buttons
go here.
BIN
The BIN directory contains binary executable files.
Synergy Training 6 Weber Systems, Inc.
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ASCRPT
The Synergy script library base for the system isestin this directory.
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Introduction to the Interface

Throughout Synergy’s documentation, specific terminology sefespecific areas of the screen. These
areas are illustrated in the image below.

Main Menu Tab Menus

|— _{/Grogannt/C/uzifweber/ aichive/glsamplefievizion /synfile
File Edit Mi Seftings  Property  Show  Inquire Info & W * Help

Title Bar: —>

Prompt line - ? _ Construct | Rims | win_| Tum | 30 mach | 30| sdv 30 | pratting | peentrol
i /_,' | j Foints Lines Circles Holes Splines Curves Trim Macros
Input Line = =
.‘ﬂ+.] . | ..l | .l | .l .l .l l.l | ‘ l'ﬂﬂ| o)x] j |I] Solid leemangular lend Pt j|
Color Controls iew Refresh Zoom Render Drawings Yiew 1 View 2 View 3 View 4 Yiew 5

Graphics Menu

Layer Controls LineType Controls Input Controls

Release 12 Interface Changes:

Raising the Tab menus

The Tab Control Menud€XV andM) have been moved to t# menu. Tab menus can be raised
and lowered by selecting the appropriate item from&h@enu.

To raise the D tabs, clich - Design
To raise the V tabs, cliclh = Variational
To raise the M tabs, cliclA > Misc

Undocking menus

Menus other than the main and graphics menus can be kedidcom their default locations.
Clicking and dragging a menu on any non-button area will chkathee menu and you can move it
around the screen. Menus will automatically snapeaettges of the screen, or you can choose to
have the menus “float” freely.

Where is the Icon Bay?

The Icon bay is not raised by default. To raise theN@@y, open the AMO Mill, AMO Lathe, or
Lathe Tools interface from th& menu.

The “except” check box

The “except” button on the layer and color control (forlgnerarked with a “-”) has been replaced
with a check box. When the box is checked, the except maativs.

Color Change Buttons

TheE,B,C andl buttons have been integrated into a pop up menu accesskcking on the area
on the far left of the color controls that indicaties active color.

Synergy Training 8 Weber Systems, Inc.
Document Produced by deskPDF Unregistered :: hitp://mww.docudesk.com



Synergy Lathe

The File Menu

Main Menu: File = New

Synergy will ask you to confirm that you want to startew job. Enter "Y" to start a new file, enter "N" t

abort procedure. Then you will have the opportunity t& ie CAD settings that you are going to use in
the next file. CAD settings are predefined system vlriséttings that are used to determine things like

measurements, scales, and other variables.

Main Menu: File - Open

This command can open an entire Synergy file, or jestitdis geometry or TurboPost. Since Synergy can
only work on one file at a time, any thing that yoa enrrently working on that you have not saved will be
lost.

» Enter [E] to open the entire Synergy File

» Enter [G] to open just the file’s geometry

* Enter [T] to open only the file’s TurboPost inforneeti
» Enter [N] to cancel the open procedure.

» Enter [C] to open the NC Tape

Main Menu: File - Merge - Current Position

This command reads a file and places it at its origotation. Enter [U] to undo the file placement. Enter
[M] to finalize the merge

Main Menu: File - Merge - Reposition in 2D

This command reads a file and places it in severalitmain 2D Enter [U] to undo the file placement.
Enter [P] to finalize the merge

Main Menu: File - Merge - Reposition in 3D

This command reads a file and places it in severalitmzin 3D  Enter [U] to undo the file placement.
Enter [P] to finalize the merge

Main Menu: File - Save

This command saves a file into the current locatiéou are encouraged to use our Archive system rather
than this method of file storage.

» Enter [E] to save the entire Synergy file.

» Enter [G] to save only the drafting geometry of tihe f

Main Menu: File => Save As

This command saves a file at the current location leisd/ou enter a name and description for the file.
You are encouraged to use our Archive system rather tisaméthod of file storage.

» Enter [E] to save the entire Synergy file.

» Enter [G] to save only the drafting geometry of tihe f
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Main Menu: File - Copy File
This command will make a duplicate of a file.

Main Menu: File -> Delete File
This command will delete a file.

Main Menu: File -> Exit

The Edit Menu

Main Menu: Edit - Undo / Redo
Synergy 12 has the ability to undo and retamy, but not all actions.

You can tell when an action can be undone by checkingrttie buttorafter you have performed the

action. If the last action may be undone, the undo bigtactive. If there are no actions in the undo louffe
or Synergy is in the middle of performing an action,uhdo button appears faded. Actions that may not be
undone will clear the undo buffer and the undo button withlbak.

Limitations -- Functionsthat can be undone

* Most geometric constructions both 2d and 3d

* Most entity trimming functions

* Most rotate, invert, move, copy, scale, and projeattions

* Most drafting entities and geometric tolerance featuxe$o

* Most delete functions, except for deleting all of a ¢ertigpe of entity (for example: Delete all
surfaces), or deleting variational records or objects

* Most editing of dimension entities can be undone. Excep#tfits which involve all dimensions
cannot be undone

» Creation of cutter paths for lathe, 2d, 3d and mulg-exachining

* Modification of contours such as corner radii, lead-aghamfers

* Placing a hole feature in VDM, however, reading the li@hture can not be undone

Functions that cannot be undone

»  Edits which involve all dimensions cannot be undone

» Deleting all of a certain type of entity (for example:atelall surfaces)
» Deleting variational records

* Modifying variational records, changing variables or fremapeeters.
* Auto-linking a contour

e Manually linking a contour

* Unlinking an entity, dimension, group or contour

e Saving and archiving

» Embedding a file or execution of a thread in VDM

» Creation or modifying a variable value

» Assignment of tools, work zones, info packets and iterpepti@s

» Creating, modifying or deleting a boundary

» Creating, modifying or deleting an area fill

» Creating or deleting a VDM Object

* Plotting, zooming, viewing, and other graphical fuocs

* Changing of system settings

Synergy Training 10 Weber Systems, Inc.
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* Recalculation of 2d or 3d cutterpaths in a non-vdm envirohmen

* Modification of 3d cutterpath entities

* Executing a strategy in VDM

» Executing all in VDM

» Executing an object in VDM

* Delete last record in VDM

* Reading a hole feature in VDM, however, placing the li@hture can be undone.

Main Menu: Edit - Delete

Use the commands listed under this menu to remove ftemsyour geometry. Delete can remove a single
entity, multiple entities, all the entities, entitiasa box. It can also delete items by property (line tgptr,
layers, etc...).

Main Menu: Edit - Delete - Property

You will find commands under this menu for deleting propersash as tools, operations, material and
workzone data.

Delete an area fill by selecting Main Menu: EditDelete> Property> Area Fill

Main Menu: Edit - Delete - Group

This sub-menu contains commands for deleting groupshargktthat synergy considers groups. This
includes: Contours, Names, Plot Groups, Tool Images, andri3ions. This menu also contains the
commands for unlinking linked contours.

Main Menu: Edit - Delete - Types
This submenus contains the special delete commands thaggduause if you are working with types.

Main Menu: Edit > Geometry

This menu contains commands that you will use when yamt ¥ make changes to existing geometry. You
will find commands for making changes to Dimensions, Endt®ocontrol points, weights, whole depths,
diameters. You will also find the commands for strigiglgeometry under this menu.

Main Menu: Edit - Tool Library

When working with, creating, or changing your tool dity;, you'll need the commands located in this
submenu.

Main Menu: Edit - Types
When working wit Types, you'll need the commands locatgtis submenu.

Main Menu: Edit - File Info
This command gives you access to the file header. ¥olinaited to 4096 characters in the file header.

Main Menu: Edit - Last Scripts

This command will give you a list of the scripts thavé been run recently. You can pick any script in the
list to repeat it.

Main Menu: Edit - Script
This is a way to edit a script from within Synergy.
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Main Menu: Edit - Interface

These commands are used for creating custom interfzadkex] Utility Kits. See the section on utility kits
for more details.

The Misc Menu

Main Menu: Misc - Re-Start
Use this command when you want to begin again. This il gét you out of an error message.

Main Menu: Misc - Leave Script
Use this command when you want to exit a script withontpdeting it.

Main Menu: Misc - Redo Last Operation
This command should really be named “Repeat” Last Gparathis command repeats the last operation
performed.

Main Menu: Misc -» Calculator, Clock & Term Window
These commands give you access to software that wagitten by Weber Systems. Calculator launches
your systems default calculator. Clock brings up you syst@hock pallet. Term Window launches a Korn
Shell.

Main Menu: Misc = NC Docs

This command will launch your system’s default webnser and display the current NC docs for the job
you are working on. The web browser will display therent job’s CNC output, command file, Tool list,
Time analysis and cost analysis.

The Settings Menu

Main Menu: Settings - Input
These are the methods by which you place informatidhescreen. You can either enter the absolute
Cartesian value of the locations you are entering, ighgalled absolute xyz input), or you place the data by
picking the location on the screen. (This is called dynamput.)

Main Menu: Settings -> Cad Settings

The purpose of the Cad Settings info packet is to setusadefault parameters in the system which were
previously hard coded into the setconstants or usercosstijtts. The Cad settings packet is selected when a
New File is specified.

Main Menu: Settings - Constants
This file sets many of the systems named variablessd nclude, default values used to create 2D and 3D
geometry and manufacturing, and storage directories foamabmaterial libraries. This file is located in
/usr/weber/ascrpt/ and is callsgticonstants. If any customizations are done to this file it musinioved to
/usr/weber/contrib/ascrpt, so that it is not overttemi by an update. The Cad Settings over write the
constants.
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Main Menu: Settings -> Defaults

This script allows system default values to be sets&lvalues are temporary for the synergy This script
allows system default values to be set. These valedgm@mporary for the synergy session that you are in.
When you exit Synergy and come back in the values willeg ko the defaults.

Main Menu: Settings - Variables

Allows the value of named variables to be changed. Tvedaes are temporary for the synergy session that
you are in. When you exit Synergy and come back in the svaliliego back to the defaults.

Main Menu: Settings - User Views

This allows the user to capture an area of the scretoraate a view out of that. The user views can be
accessed from the graphics menu area uvigey 1, View 2, View 3, View 4, View 5.

Main Menu: Settings - Inverse Pens

Inverse pens are used for movingadbjon the screen without erasing the graphicghbgt
pass over. There are 5 inversevptues 0,1,2,3,4.

Main Menu: Settings -> Storage Mode

This script will change the mode"foow to save files." You can save the entire job, st
Geometry, or just the turboposbrimation, (command_file and tapefile).

Main Menu: Settings - View Resolution
This script will set the resolutian ¥iewing geometry.

Main Menu: Settings -> Plot Resolution

This script allows system default values to be sets&lvalues are temporary for the synergy session that
you are in. When you exit Synergy and come back in the svalillego back to the defaults.

The Property Menu

Main Menu: Property -> Layer

The layer options allow the user to separate padgalb by placing sections of the job under a different
number. The user can layer by an Entity, Contour, Batity Type, Workplane, or Dimension. The also be
accessed from the Color Control Area in Synergy.

Main Menu: Property -> Color

Allows the user to change the current color or changedioe of entities in a job. These can also be
accessed from the Color Control Area in Synergy.

Main Menu: Property - Line Type

Allows the user to change the current line type or chamgérte types of entities in your job. These can
also be accessed from the Line Type Control arearier8y.

Main Menu: Property - Tool
Allows the user to assign a tool to either and engitgontour or by using the box method.
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Main Menu: Property -> Work Zones

Allows the user to change a work zone or assign georttetryvork zone by different methods. A work zone
is a work area on a part There are several exampla®g wbe might use work zones: Tombstone work, parts
that have many faces or sides, or fixture offsets.

Main Menu: Property - Name
Allows a name to be assigned to an entity.

Main Menu: Property - Hide
Allows you to hide or unhide different entities of your.job

The Show Menu

Main Menu: Show - All Data
Will show all geometry on the screen.

Main Menu: Show - Color
Will show all entities of a specified color.

Main Menu: Show - Layer
Will show all entities of a specified layer.

Main Menu: Show - Line Type
Will show all entities of a specified line type.

Main Menu: Show - Group

This script allows a group that waascsically made as a plot group to be plotted. The group is
associated with specific layers eoldrs.

Main Menu: Show - Tool
This script allows geometry assedatith a particular tool to be plotted on the screen.

Main Menu: Show -> Work Zone
This script allows geometry assedatith a particular work zone to be plotted on the screen.

Main Menu: Show -> Operation
This allows a chosen operation or hole feature toltitted on the screen.

ON-OFF SWITCHES

Main Menu: Show - Hidden
This will turn on-off the plotting of hidden geometry.

Main Menu: Show -> Dimensions
This will turn on-off the plotting of all dimensions.
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Main Menu: Show - Area Fill
This will turn on-off the plotting of area fills that are done under Dnaft>Hatching.

Main Menu: Show - Tables
This will turn on-off the plotting of tables that are created in drafting.

Main Menu: Show -» Surfaces
This will turn on-off the plotting ofthe surfaces that were created in 3D.

Main Menu: Show - 3D Cutter Paths
This will turn on-off the plotting of 3D Cutter Paths.

Main Menu: Show -> 3D Cutter Path Arrows
This will turron-off the plotting of 3D Cutter Path Arrows.

Main Menu: Show - Trim Curves
This will turn on-off the plotting of all trim curves.

Main Menu: Show - Ruler
This will turn on-off the ruler or drawing grid. The hotkey for thisGsr| R.

The Inquire Menu

Main Menu: Inquire - Highlight

This will show what is grouped or autolinked by turning ethéng in the group blue. It will also show
arrows that indicate the direction of the autolink.

Main Menu: Inquire - Group Highlight
This is the same as Highlight but the user will cleab® name of the group to be highlighted out of a list.

Main Menu: Inquire - General (work space)

This will show the information péniag to a particular element relative to the standelative
to the current workplane.

Main Menu: Inquire - General (real space)
This will show the information pertaining to a particutde@ment relative to the standard work plane.

Main Menu: Inquire - Distance
This script measures the perpendidigéance between a point and an entity.

Main Menu: Inquire - Angle Two Lines
This script measures the angle éetwwo lines.
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Main Menu: Inquire - Contour

This script will interrogate a cortand bring up the relevant information in the CONTOUR
INFO BOX for viewing.

Main Menu: Inquire - Volume
This script calculates the volumefemie area, and centroid of a part.

Main Menu: Inquire - Part Limits
This script calculates the maximummaimdmum limits of a 3D part.

Main Menu: Inquire - End Point
This script interrogates an elenaert will display the coordinates of the end point.

Main Menu: Inquire - Pick Point

This script interrogates an elementwatidiisplay the coordinates of the pick point in the PICK
POINT info box for viewing.

Main Menu: Inquire - 3D Fillet Radius
This script finds the radius of aleirmontained in a 3d fillet surface.

Main Menu: Inquire - Data Size
This script will place the databasermation in a file box for viewing.

Main Menu: Inquire -> Scallop Calc
This script will calculate the Scallop height.

Main Menu: Inquire -» List
This script will list the specified entities.

The Info Menu

Main Menu: Info

This is a tear off menu that will show general infation. It can also be used for stepping through the CNC
code one block at a time.

Working with the Graphics Menu

Synergy offers precision control over your viewing aréagithe menus contained in the graphics menu.

Graphics Menu: View

All of the options in the view menu are used for conitiglthe angle from which Synergy displays your
graphics. The following is a list of options:

e Top

« Bottom

e Front
 Back

* Right Side
» Left Side

e Isometric
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* |sometric 2

* |sometric 3

* |Isometric 4

e H (horizontal) mill view
 Lathelso

Rotate
This brings up th&otation Angle dialog box. Use the slider to rotate the view aboutliaey Choose the
axis of rotation by clicking on the axis described ingh@mpt line.
If you wanted to rotate the view about the Y axis:
1. Chooseview menu: View - Rotate. The prompt line will reaMOVE SLIDER Xaxis,
Yaxis, Zaxis, Turn90, Reverse?
2. Click Yaxis in the prompt line.
3. Slide the otation Anlgle slider.
4. When you are satisfied, Click thet button.
Exit
You must manually exit the Rotation Angle Dialog box wheun gre rotating your views.
Axis
The axis button lets you pick the line you want Syneogyse as a reference for the rotation. Synergy will
not rotate about a point or circle you must pick a line.
Zero
The zero button sets the rotation angle for the asirsglrotated about to zero.
Refresh
Fit
Fit automatically scales the your geometry to make isaqgpears in the graphics window.
Redraw
The redraw button will recreate the geometry in th@hjes window. Use this feature to clean up artifacts
that might appear on your screen without resizing your view.
Refine
Use refine when you want to ensure that your screengepim an accurate representation of what is really
being created. This is especially useful when you arsiderably zoomed in on your geometry.
Resize All
If you are working with multiple graphics windows, resatlewill perform fit across all of them.
Refine All
If you are working with multiple graphics windows, refialéwill perform refine across all of them.
Synergy Training 17 Weber Systems, Inc.
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View On and View Off
Once you have created drawing views in your geometrycgouurn those views on or off by using these
commands.

Zoom

Zooming is self-explanatory. Zooming in on your geometigied you to view the fine details of your
geometry up close. Zooming back lets you view all youngdny from a distance to get an overall view of
the part.

Synergy offers several methods of zooming.

Graphics Menu: Zoom - Two pt. Zoom <f3>

Two point zoom lets you zoom in on your geometry usidgreamic zoom box. The dynamic zoom box
grows and shrinks from its center.

To zoom up on geometry

1. Select Graphics Menmoom - two pt. Zoom
2. Click on the approximate center of the area you areggoizoom in on.
3. then move your mouse away from that point. Notice th@wzoom box expands from the

center point automatically.
4. Click again when you have enveloped the area you wigbora in on with the zoom box.

Graphics Menu: Zoom - Previous <f4> and Graphics Menu: Zoom - Next <f5>

Zoom Previous and Zoom next let you switch back and foattvden previous zooms. Each time you
zoom, Synergy remembers where and what you zoomed. 2aoaxt and zoom> previous let you
quickly flip back and forth between zooms.

Graphics Menu: Zoom - half <f11> and Graphics Menu: Zoom - Double <alt> + <f11>
Zoom->» half automatically reduces the scaling factor by.tdoom-> half zooms back.

Zoom->» double automatically increases the scaling factor by @om->double zooms in.

Graphics Menu: Zoom - Unzoom

Unzoom resets the graphics window to the last fitqperéd. It is the same as clickifkgfresh-> fit, except
that Synergy will not check to make sure that allghemetry is contained in the graphics window.

Graphics Menu: Zoom - Pan <f6>
Panning lets you move the view around in the graphingaw.

Render
Synergy’s rendering abilities have been enhanced withdidlié@n of Open GL manipulation and viewing
techniques. On the surface, these changes are transphegntising Synergy's View: Render menu
commands, however, OpenGL makes working with and visual&irfgce and wireframe geometry
considerably easier.

View: Render - Refresh
Puts Synergy into an OpenGL mode where you can work withgemometry as shaded surfaces.
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View: Render -» Refresh / Wire

Puts Synergy into an OpenGL mode where you can work withgemmetry as shaded surfaces and visible
wire frames

View: Render 2> Wireframe
Puts Synergy into an Open GL mode where you can work withgemmetry as OpenGL wire frames

View: Render - Rotate

Use this command to put Synergy into a Viewing Mode gftarhave rendered your geometry. The
viewing mode is for rotating, zooming and rendering geonanly. You will not be able to create or make
changes to geometry when you are in the viewing modes Resg> to leave the viewing mode.

While in the viewing mode, use your mouse to manipulate thegiey:

» Left Click and hold while you drag your mouse to tilt yg@ometry

* Middle Click to Pan your geometry

* Right Click to zoom your geometry
Panning and Zooming are mode based, and will requirenaah@left) click to exit from panning or
zooming mode. Tilting is not mode based, and thereitirey does not require a second click to exit from
tilting mode. Simply click and hold the mouse button whil@gging to tilt your geometry.

View: Render - Render Off
Turns off Synergy’s OpenGL functions.

View: Render 2 Remove Triangles
This is a command that is used to remove superfluous regdeformation from your computer’'s memory.

Drawings

View: Drawings -> On and View: Drawings -> Off
This is a toggle menu for turning the display of drawingswd off.

What are drawings?

Synergy Drawings are methods of displaying data in the &randrafting drawing without creating
separate geometry for each view. Drawings are onlyiéwing. It is not possible to work with the
geometry represented You will need to specify the length &ittl wf the drawing. The lower left corner of
the drawing is always placed at zero. A negative lengtidih may be necessary for drawings imported
from IGES.

Once you have specified the drawing’s length and widith egw is placed and clipped on the drawing
relative to the lower left corner.

Once specified, the drawings may be deleted, moved, anddotahe clip points and views may be
changed.

To plot a drawing to scale, the length and width ofdteeving must match the physical dimensions
available on the plotter.

Synergy’s drawings differ from IGES drawings.
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User Views

The remaining buttons on the Graphics Menu are threviesgs. These buttons are marked View 1, View 2,
View 3...

They are used to quickly switch between predefined cusimmsettings.

Input Options
Absolute (XY2Z) Input

Synergy has two main ways of asking you where you waplatze information on the screen. You either
enter the absolute Cartesian value of the locationsay® entering, (this is call absolute (xyz) input), ar yo
place the data by picking the location on the screenigticiled dynamic input).

Which method of input you use is controlled using the icpatrols located on synergy’s main interface.
(See: Introduction to the Interface.)

XYZ INPUT OPTIONS

Rectangular [R]
This option creates a point at the X,Y,Z coordinatesster.

You have three more options when in rectangular mode, wbicltan also control using the input controls.

Center return
A point is created at the coordinates of the arc cente

Midpoint return
A point is created at the coordinates of the midpoirat lafe.

End point return
A point is created at the end point nearest the point picked.

Free Point  [f]
This option creates a point at the present cursoritocat

Intersect N
This option creates a point at the intersection ofdlements.

Nearest [N]
This option will create a point nearest to the cuosothe entity

Polar [p]
This option creates points that are defined in polar coatel (radius and angle).
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Spherical [s]

X & Angle  [xa]
This option creates a point at an absolute X locatiohesnangle. The angle is referenced from the last
point

Y & Angle  [ya]
This option creates a point at an absolute Y locatiohaanangle. The angle is referenced from the last
point.

X & Hypotenuse [xh]

This option creates a point at a known X coordinate sspkeified distance from the last point described. If
the specified distance does not intersect the X coorJinatpoint is created.

Y & Hypotenuse [yh]

This option creates a point at a known Y coordinate sspkeified distance from the last point described
NOTE: If the specified distance does not intersecivticeordinate, no point is created

Hypotenuse: Angle [ha]
This option creates a point at a specified distance ragléd &#om the last point described

X & Entity  [xe]
This option creates a point on an entity at a knownc&tion

Y & Entity  [ye]
This option creates a point on an entity at a knownc¥tion

Angle: Element: [ae]
This option creates a point at a specified angle inténgegn entity.

Lathe Point [lp]
This option creates a point using Z-axis and diameters.

Selecting Input Options Automatically

Position the active point with your cursor. Clickintpeation on the viewing window selects a point
according to the following rules:

1. If the cursor is within the pick distance of an existintty it will pick the entity in the same method
as an ordinary XYZ input.

2. If no entity is within pick distance it will selecffr@e point. The free point is always on your existing
work plane and has a Z coordinate in the work planeraf. z

3. If your cursor is on a ruler, the program will selde closest ruler point.

Be careful not to place the cursor close to an eggitity, because the program will select the entithe(
#1) before it selects a free point (rule #2.)
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Absolute Input Keyboard Shortcuts
To manually select the active point, use the following keys

<R> Enters normal XYZ input. All normal functionseaactive.

<N> Enters Nearest Mode.

<I> Enters Intersect Mode.

<LP> Enters Lathe Input Mode.

<E> Exits the dynamic mode and leaves script.

<B> Backup. Destination determined by the script.

<XX> Restart script. Goes to beginning of script. (Somesi B and X will have the same
function.)

Dynamic Input

Dynamic input allows the entity to change in referenaédocation of the cursor.

While most commands require only one point to defineetitdy, some commands require two points. For
example, commands that require picking two points incliid®e Two points, Circle Rad Two Points, Axis
Cylinder and Line Plane.

Dynamic Input Keyboard Shortcuts

Not all of these keys are active for all entitiest Example, some entities, (like torus) may have degrfees
freedom not addressed by these keys. Some entitiasowilise some of the keys. (There is no reason to
adjust the radius of a rectangle.)

You can experiment with the keys to determine what keysetive on which occasions:

[+/-]
[6]
[4]
[8]
(2]
9]
[7]
3]
[1]
[>]
[<]
[1]
[[]
/]
[*:]

changes the sign of an angle.
increases the starting angle.
decreases the starting angle.
increases the angular extent.
decreases the angular extent.
increases the a second angle.
decreases the a second angle.
increases the a third angle.
decreases the a third angle.
increases the radius/length.
decreases the radius/length.
increases the second radius/length.
decreases the second radius/length.
increases the third radius/length.
decreases the third radius/length.
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SYNERGY ARCHIVAL PROJECT SYSTEM

The synergy archival project system is a method gédunizing the storage of synergy projects. It uses
the standard hierarchial file system that is presert@iNT operating system.

Each project which is archived contains all the fildssch can be associated with that project. In
addition
each time a given project is archived a new renisitthat project is created.

The archival system provides utilities famaging the project archive, for retrieving archived
projects, and for browsing the components of archive i

DIRECTORY STRUCTURE:
The default start or the project archive is in
lusr/weber/archive/
This location is specified in a system Jadacalled
"archive dir"
Changing this variable in userconstants will relodagestart of the project archive.

A user may have multiple Synergy archives. Accessdadliffierent archives may be obtained by
modifing the archive directory variable.

In the archive may reside either simplggats or directories of projects.

SIMPLE PROJECTS:

A simple project is a directory having a valid file remhich contains all the revisions of that project.

Each revision contains a text file called info.txt wheontains information about that project, revisiotero
and a list of the component files of that project. Fiermation contained in info.txt is patterned aftes t
template file located in /usr/weber/database/propertigje?s.

The component files can be the following:

synfile: The synergy file stored in synergy format.
command_file.txt: The synergy turbo-post command file.
tapefile.txt: The synergy turbo-post CNC file.
notepad.*.txt: The turbo-post notepad files in .txt format.
notepad.*.html: The turbo-post notepad files in .html format.
*.hpgl: The .hpgl plotter files.

*.gif: Any .gif images associated.
*jpg: Any .jpg images associated.
*.html: Any .html files associated.
*.htm: Any .htm files associated.
*.doc: Any Microsoft word .doc files associated.
* xls: Any Microsoft Excel .xls files associated.
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The choice of components to be archived is specifigtidgystem variable:
"archive file types"
This is set by default in setconstants and may be setricomstants or changed on the fly.

Valid project names should consist of alpha-numeric seqaenith dots or underbars. Other characters

should not be used especially spaces, colons, commasclestslashes, backslashes, # etc. These characters

create problems when we are using regular expressiagaradirectories.

A more descriptive name can be used in the info.txaBkociated with each project.

DIRECTORIES OF PROJECTS:

A directory of projects is a directory which contagme or more synergy projects.
A directory of projects contains information about types of projects contained in the directory in the file
dinfo.txt. The information contained in dinfo.txt is patted after a the dirtemplate file located in

/usriweber/database/properties/Projects.

We recommend naming the directories with a name whishchas a suffix. This is not a requirement.

Archive your job
It's time to save the changes you've made. You can ddyhising Synergy’s Archive feature. From the
Main Menu, choos€&ile 2 Archive > Save 2 Archive

The following instructions are for creating a new p roject directory from scratch:
The prompt line box will ask:

SELECT PROJECT New directory, List?

This prompt means that you have to tell Synergy whenenamt to archive your file. Because
this part has never been archived before, you are ¢icrgate a new directory.

Click the wordNew in the prompt line. The prompt will ask you to natne nhew directory:
NEW PROJECT DIRECTORY NAME?

Enter:Training.d

Fill out the Multi-entry dialog box. You can name this g@fything you want to in the name box (but avoid
numeric expressions). Enter a description. Enter youen&mter a status. Then click & button.

The system has placed you (although it doesn’t show yineabp yet), in the usr/weber/archive/training.d
directory.

SELECT PROJECT New directory, List?

This question is now asking for the project name.
Name the project by typing into the input line, therspreEnter>. Call this sample file: ex_one.
Fill out the next multi-entry dialog. Enter the followingaa

Project name: Exercise One
Description: (Describe the part)
Author: (Put your name here)
Status: In Progress
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When you have finished, click OK.

Now that the part has been archived, you can always kestpafrthat directory the part is
stored in because the directory path will be displayeSyorergy’s title bar.

Now chooseéM ain Menu: File > Archive 2 List > ArchiveList and find your new project
in the list.

Data Exchange

IGES

IGES is an acronym fdmitial Graphics Exchange Specification, an ANSI graphics file format for three-
dimensional wire frame models.

Import
You are going to start by importing an IGES File. Fromrtiain menu, find and click File Import >
IGES> New
The prompt line will ask you:

THIS ERASES THE CURRENT JOB LOAD Yes/No ? REN =

This is a safety mechanism. When you import an IGESS§inergy assumes that you are starting from
scratch. Any data that you might have on the screemeébgfm clicked the Import IGES button will not be
saved once you answer “Yes” to this question.

When you choose your file from the box that comestuipoks in that file to see whether certain attributes
have been set.

Click on or type <Y> and press <Enter>. The prom liwill instruct you:

CHOOSE EXISTING IGES FILE FROM FILE BOX
Synergy will present you with a file dialog box where yall locate the file you want to open.. You may
need to use the scroll bars and scroll the list@ffames until you find it.

Reading the IGES Global Data

After Synergy has imported an IGES file, it will displaynergy's IGES global data window. This window
gives you information about the file, including product idesgtion, the name, the system filename,
translator version, creation date, the scale, &S version number, and so on.

If you scroll down this information using the scrolkdan the right side of the global data box, under a
section headed “Entity Totals,” you may also see infdion about the geometric entities contained in the
file. For example, an IGES type number 100 is a cigezid, it will give you the entity count of what it has
just imported.

Look at the bottom of the list, you'll see a key to uistinding the markings that may or may not appear
next to the entity listings.

The key says: “* these entities are not translataa]“a these entities are only partially translated.”

This means that when an entity is marked with aniakté), Synergy is indicating that the information was
contained in the original IGES file, and for whatekegison, Synergy was unable to read it. This could be
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because the entity contained corrupt data so it was skiffgn entity is marked with a plus sign (+), it
indicates that the entity was read, but it may not heesn translated on a 1-1 basis. Normally, this is
because the original file contained a custom coloa, @lor that’s not directly translatable accordinghte
IGES standards. In this case, Synergy will translatanifi@rmation to the nearest similar Synergy color.

Once you have looked at the IGES global data windowgcgouprint the information if you find it
important, or you can click Cancel, and move on.

The IGES Widget

The IGES widget is a tool that gives you the abilitgetect which parts of an IGES file you want imported
into Synergy. You have the option of not using this widgetiarporting the file in its entirety, however,
there may be certain entities in some files that dsete any purpose when imported into the Synergy
environment. The IGES widget lets you choose not to itthese entities.

The variable for turning the IGES widget on and off barfound in Synergy’s main menu. Click Settings
- Variables. Look for the variable named: “use IGES widge

A switch box called the IGES WIDGET (program name: igsget) is available through the named
variable "use IGES widget". When "use IGES widget" is®séyes"”, the widget will be run, while a value
of "no" indicates that the widget is not in use.

When you are running the widget, it will start automalyoahen you attempt to import an IGES file.

More information is available in the IGES widget hi#pflocated in
usr/weber/filing.d/importigs

! igz_widget [_ O]
Eile  Optionz  Help
—IGES File Selection
Input IGES file name:l Browse. .. |
Cutput Synergy file name:ligsnut j Browsze. .. |
Fiepart; IEr'ltit_'.-' totalz j
ak. | Cancel |

Using the IGES widget

The IGES widget consists of a select box with a menulG&S file name selection line, Synergy file name
selection line, Synergy name option menu and an outputt reggtion menu.
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IGES widget menus: Options
Filters:

Brings up a window where you can pick and choose how you Migaltb filter six different aspects of an
Iges file: including Surfaces, Drafting, Propertie¥, Trims, XYZ Trims, Dependencies.

Trimming:

Brings up a window where you can select how you would likee®yy’'s IGES translator to treat the
trimming methods used on five surface types (Nurbs, RewalitiTabcyls, Parasplines, and Ruled).

Special:

This brings up a dialog box that lets you control misoekas options. You can set the IGES translator’s
Tolerance factor, Entity timeout, Convert nurb saiégree, and determine with which directories and
entities you would like the translator to skip.

IGES Entity Types

100
102
104
106
108
110
112
114
116
118
120
122
124
126
128
140
142
144

Circle

Composite curve

Conic arc

Copious data - Linear path - Simple closed pla
Plane

Line

Parametric spline curve
Parametric spline surface
Point

Ruled surface

Surface of revolution
Tabulated cylinder
Transformation matrix

Ration b-spline curve

Ration b-spline surface

Offset surface

Curve on a parametric surface
Trimmed parametric surface

IGES Annotation Entites:

202
204
206
208
210
212
213
214
216
218
220
222
228

Angular dimension
Curve dimension
Diameter dimension
Flag note

General label
General note

New general note
Leader

Linear dimension
Ordinate dimension
Point dimension
Radius dimension
General symbol

IGES Structure Entities

308
402
404
408
410

Subfigure definition
Associativity instance
Drawing

Subfigure instance
View

nar path
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DXF

DXF is an abbreviation dbata Exchange File, a two-dimensional graphics file format supported by
virtually all PC -based CAD products. It was created\btoDesk for the AutoCAD system.

DXF is a very verbose, ASCII text representation ofea There are four parts to a DXF file. The HEADER
section defines values for most AutoCAD system vaemhllost of these are not useful for another CAD
system. The TABLES section defines items like lingestand user-defined coordinate systems. The
BLOCKS section contains the definitions of blockgamged in the model. The ENTITIES section contains
the entity definitions and block instances. Using AutodAB possible to create a valid DXF file that only
contains an ENTITIES section.

Problem Elements with DXF

e Text

» Splines
 Views

» Surfaces

 Dimensions
« Fill Patterns
* Properties

Elements Missing From DXF

. Solids

* Nested Shape

. Offset Curve

. Curve on Surface

. Chain Dimension

e Curve Length Dimension
. Grid
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Import

Synergy is capable of reading DXF ASCII data files iméted way.Y ou can not export DXF filesfrom
Synergy. The following are instructions for importing DXF data:

You are going to start by importing an DXF File. Fritra main menu, find and click Fite

Import > DXF. The prompt line will ask you::

SELECT DXF FILE:

The selection box will appear, from which you will findddiocate your file. The prompt line will ask you:

Undo or Merge:

Enter "U" to undo (delete) the file placement. Enter thifinalize the merge. Merge must be selected to
finalize the procesg,ou will not import thefileif you do not choose merge! The prompt line will ask you:

DELETE REFERENCED BLOCKS (Yes or No):

Some DXF files may have conflicting data in their BLKOgeneration and insertion group codes. Alternating
responses to this question may solve this problem.
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Problem Elements with DXF

e Text

» Splines

* Views

» Surfaces

 Dimensions
+ Fill Patterns
* Properties

Elements Missing From DXF

. Solids

* Nested Shape

. Offset Curve

. Curve on Surface

. Chain Dimension

e Curve Length Dimension
. Grid

Synergy is capable of reading DXF ASCII data files iméted way.Y ou can not export DXF filesfrom
Synergy. The following are instructions for importing DXF data:

You are going to start by importing an DXF File. Fritra main menu, find and click Fite¢ Import—> DXF.
The prompt line will ask you::

SELECT DXF FILE:

The selection box will appear, from which you will findddiocate your file. The prompt line will ask you:

Undo or Merge:
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Theoretical Tool Tip

The standard synergy lathe post-processors use thabtetittip programming. The theoretical tool tidasated
by intersecting tangent lines drawn horizontal and veitiicéne tool nose radius. This point is not actuallyoint
on the tool.

If theoretical tool tip programming is not used thestncommon alternate method is to program the to@ nos
circle center.

Theoretical tool tip programming has the advantage thad amd faces are programmed with the numbers that
appear directly on the part design. On the other handstapd radii do not correspond to numbers on the design.

Tool nose radius programming has the advantage thauthbers which appear are just a uniform offset froen th
design contour.

Lathe Machining paths in synergy are generated to thi@tse radius center. This is the path drawn in synergy.
In turbo-post this path will be output in either theoittool tip mode or tool nose radius mode, depending®n th
post processor setup. Again standard lathe turbo pesteoamally set up to do theoretical tool tip programming.
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Auto Link

Autolinking creates a contour (a special type of group), treathgin of connected elements. An Auto Link
should only be done ONCE for any group of elements. EaghAuto Link is used the new contour is added to
the list of groups. To check to see if something hasdyrbad the Auto Link option used, use the
HIGHLIGHT option or check the list of named groups.

Auto link can only be used on your geometry once. It capmoepeated. Double elements will prevent a
successful Auto Link.

INSTRUCTIONS:

PICK START ELEMENT, Single: Pick a point on the sta rting element near the
desired start point. This pick will determine the d irection of the
Auto Link. Single allows the Auto Link to proceed o ne element at a
time and should be used if there are a lot of place s where a decision

about which direction to continue.

PICK NEXT, Backup, Single, New: Backup allows the A uto Link to be moved
back one element at a time, starting at the ending element. This
element will no longer be included in the contour ¢ reated by the Auto
Link. Single allows the Auto Link to proceed one e lement at a time
and should be used if there are a lot of places whe re a decision about
which direction to continue. New allows a new grou p of elements to
use the Auto Link option and creates a new contour. The new contour is
automatically named contour#, where # is incremente d each time a
contour is created. You can always rename the conto ur later.

PICK END ELEMENT: Pick the element where the Auto L ink process should
stop. If the first element is picked twice, the Aut o Link will proceed
around the contour as far as it can, back to the fi rst element if the
contour is closed and there are no choices of a dir ection.
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Autoundercut: Undercut Roughing Cycle

The tool clearance angle is used to determine unreadchi@ale of the starting contour, called undercuts.
Successive paths rough out these undercuts where the depthiofletermined by the amount of material to
remove and the number of cuts requested.

Lo
@

Auta Undercut

INSTRUCTIONS:

SELECT TOOL: Select the undercut tool.
NUMBER OF CUTS: Enter the number of passes.

FINISH ALLOWANCE: Enter the diameter and length amo unt of material to be
left for a finish pass.

PICK PATH: You have two choices. 1) Pick the contou r to be roughed. This
will force a tool clearance angle question to defin e the undercuts. 2)
Pick a previously defined roughing path. This will use the data
associated with the rough path to determine undercu ts.

TOOL CLEARANCE ANGLE: Enter the cutting edge cleara nce angle of the tool
that left the undercut. If the tool is not selected the following
guestions will appear:

TOOL NOSE RADIUS: Enter the tool nose radius of the tool to be used.

TOOL QUADRANT: Enter the tool nose quadrant.

Synergy Training 33 Weber Systems, Inc.

Document Produced by deskPDF Unregistered :: hitp://mww.docudesk.com



Custom Turning Applications

Diameter and Length Finish Allowance

1/¢ Diameter allowance with Mose Radius

Length allowance with Mose Radius =&

INSTRUCTIONS:

DIAMETER FINISH ALLOWANCE: The total finish allowan ce added in diameter to
the contour to be machined.

LENGTH FINISH ALLOWANCE: The total finish allowance added in length to the
contour to be machined. The contour being machined is shifted in X and
Z by an amount equal to half the diameter finish in X and the length
finish in Z. The direction of the shift is determin ed by the quadrant
of the tool.

UNDERCUTS: When dealing with undercuts the followin g rules apply: For
longitudinal cuts. The length finish allowance is a dded to the tool
nose offset and the undercut contour is offset by t his amount. The
excess diameter finish allowance is then used to sh ift the offset
contour in X. For radial cuts, half the diameter fi nish allowance is
added to the tool nose offset and the undercut cont our is offset by
this amount. The excess length finish allowance is then used to shift

the offset contour in Z.

Synergy Training 34 Weber Systems, Inc.

Document Produced by deskPDF Unregistered :: hitp://mww.docudesk.com



Custom Turning Applications

Finish Groove

Use this technique to create a path to finish cut a gnedtespecified width and depth. A roughing groove
path may be chosen to use pre-specified values for gradite and depth.

Start point

=
Lol
—t
-
.
¥
—
1yl
]
—
-

INSTRUCTIONS:
SELECT TOOL: Select the finish grooving tool.

GROOVE WIDTH: Enter the width of the groove to be c reated.

GROOVE DEPTH: Enter the depth of the groove to be c reated.

GROOVE START POINT ABS X,Y: Enter the X,Y coordinat es for the start point
of the groove. NOTE: See XYZ INPUT OPTIONS.

FINISH ALLOWANCE: Enter the amount of material to r emain. If the tool is

not selected the following questions appeatr:
TOOL WIDTH: Enter the width of the grooving tool.
TOOL NOSE RADIUS: Enter the tool's corner radius.
TOOL QUADRANT: Enter the tool nose cutting quadrant
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Finish Groove A Contour.

Use this command to create a pathgroup to finish cohsour with a grooving tool. The contour must be
"groove like," that is, for an Od groove that the diamdé&ereases and then it increases.

The finish cut will start cutting the contour with oridesof the tool until its center reaches the split ppins
the overlap. It will then retract, go to the other efithe contour, and cut with the other side of the dioein to
the where the last cut left off, plus the overlap. §hmoving tool must fit in the groove. This cycle wrilht
produce a correct path if the tool cannot fit in the tiocaof the split point.

F1nish path

(Groove contour

INSTRUCTIONS:
SELECT TOOL: Select the finish grooving tool.

FINISH ALLOWANCE: Enter the amount of material to r emain.

PICK CONTOUR: Select the contour to be grooved.

SPLIT POINT: Input or Pick the point that the tool will switch sides. The
split point plus an overlap distance determine wher e the bottom center
of the groove tool will stop. If the tool is not se lected the

following questions appear:
TOOL WIDTH: Enter the width of the grooving tool.
TOOL NOSE RADIUS: Enter the tool's corner radius.
TOOL QUADRANT: Enter the tool nose cutting quadrant
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Lathe Offset

This command generates a cutter path with full, mininoamo look ahead. It will also change the path
geometry to eliminate undercuts based on the tool cleaia@mgle. The Minimum or None look ahead options
should be tried first. If the path is unacceptable thenRI{ L LOOK ahead.

INSTRUCTIONS:

LATHE Forward OR Reverse: Forward will generate a p
direction as the contour. R - Reverse will generate
the opposite direction of the contour.

TOOL NOSE RAD: Enter the toolnose radius of the cut

FINISH ALLOWANCE: Enter the diameter and length amo

ath that has the same
a path that is in

ter to be used.
unt of material to

remain.
PICK AN ELEMENT OF CONTOUR TO BE OFFSET: Pick an el ement on the contour to
be offset.
PICK WHICH SIDE: Pick which side of the contour the path should be
generated.
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Profile: Roughing Cycle
Use this command to create a group of paths spaced atzequdiitances to remove stock in length and
diameter.

Profile Contour

INSTRUCTIONS:

SELECT TOOL: Select the tool for profiling.
NUMBER OF CUTS: Enter the number of passes.

FINISH ALLOWANCE: Enter the diameter and length amo unt of material to be
left for a finish pass.

PICK CONTOUR: Pick the contour to be roughed. If a tool is not selected
the following questions will appear:

TOOL NOSE RADIUS: Enter the tool nose radius of the tool to be used.

TOOL QUADRANT: Enter the tool nose quadrant.
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Rough: Roughing Cycle

DESCRIPTION:
This command creates successive cuts in a horizantairtical orientation. The tool clearance angle elus
determine unreachable areas of the starting contdied eandercuts.

The file lathe.d/setvals sets user definable constdrite stock contour must have no undercuts. It must be
described in the same direction as the roughing cariféitin a stock boundary the Clearance angle is assumed

Zero.
|
©|
|
Longitudinal Raughing O |
Stack Boundary
-
T | e
/ ~ E
Contour q_
Radial
Roughing e
ghing (7
Contour
Jtock boundary
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[TTTRw. . Radial Stock Boundary

\;?/fStuck Boundary

/Z

Cantaur

INSTRUCTIONS:
SELECT TOOL: Select the turning tool.

DEPTH OF CUT: Enter the depth of cut (the distance between successive
passes).
FINISH ALLOWANCE: Enter the diameter and length amo unt of material to be

left for a finish pass.
PICK CONTOUR: Pick the contour to be roughed.

PICK STOCK CONTOUR: Pick the contour used for the s tock.(optional) If the
tool is not selected the following questions will a ppear:
TOOL NOSE RADIUS: Enter the tool nose radius of the tool to be used.
TOOL QUADRANT: Enter the tool nose quadrant.
TOOL CLEARANCE ANGLE: Enter the cutting edge cleara nce angle.
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Rough Groove

This command creates a path to rough cut a groove péitifeed width and depth. There are two methods of
cutting the groove: Cut_type= WsSequentialCuts, whereutseare made in a right to left or left to right
direction, and Cut_type= WsAlternateCuts, where the digihate from side to side.

Ny
O

i

J —Lepth

Start point

k]
.

Width

INSTRUCTIONS:
SELECT TOOL: Select the finish grooving tool.

GROOVE WIDTH: Enter the width of the groove to be c reated.

GROOVE DEPTH: Enter the depth of the groove to be c reated.

DEPTH OF CUT: Enter the depth of cut (this distance will be used on
successive passes).

GROOVE START POINT ABS X,Y: Enter the X,Y coordinat es for the start point
of the groove. FINISH ALLOWANCE: Enter the amount o f material to
remain. If the tool is not selected the following q uestions appear:

TOOL WIDTH: Enter the width of the grooving tool.
TOOL NOSE RADIUS: Enter the tool's corner radius.
TOOL QUADRANT: Enter the tool nose cutting quadrant
WIDTH OF CUT: Enter the width between cuts.
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Rough Groove A Contour With A Stock Contour.

This command will create a pathgroup to rough cutrdoto with a grooving tool. The stock contour is
required and limits the cutting motion to between thekstoatour plus clearance, and the groove contour.
There are two methods of cutting the groove: Cut_typeSaffgentialCuts, where the cuts are made in a right
to left or left to right direction, and Cut_type= WsétihateCuts The cuts alternate from side to side.

The groove contour must be "groove like". If the contas bumps or indentations which deviate from a
"groove like" shape then this procedure may fail. At eaclhocation this routine calculates the first
intersection of the leading and trailing edge of a steshdhaped grooving tool. It will then generate the@ut t
that location. The cuts are generated in such a wayiasui@ cuts along walls which are vertical to theoge.

O

i

(Groove contour

VA

INSTRUCTIONS:
SELECT TOOL: Select the groove roughing tool.

DEPTH OF CUT: Enter the depth of cut (this distance will be used on
successive passes).

FINISH ALLOWANCE: Enter the amount of material to r emain.

PICK CONTOUR: Select the groove contour.

STOCK CONTOUR: Select the stock contour. If the too [ is not selected the

following questions will appear:
TOOL WIDTH: Enter the width of the grooving tool.
TOOL NOSE RADIUS: Enter the tool's corner radius.
TOOL QUADRANT: Enter the tool nose cutting quadrant
WIDTH OF CUT: Enter the width of cut.
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Undercut: Undercut Roughing Cycle

The contour is made into an undercut by connectiagtidpoints. The depth of cut is determined by the
amount of material to remove and the number of @dsested.

This routine can fail if it cannot locate an undercutlmcontour. The undercut contour needs elements at the
ends to form an undercut. This can be accomplished by lalisr@ar move or a corner radius at the ends of the
contour.

INSTRUCTIONS:

SELECT TOOL: Select the undercut tool.

NUMBER OF CUTS: Enter the number of passes.

FINISH ALLOWANCE: Enter the diameter and length amo unt of material to be
left for a finish pass.

PICK CONTOUR: Select the contour.

If the tool is not selected the following questions will appear:

TOOL NOSE RADIUS: Enter the tool nose radius of the tool to be used.

TOOL QUADRANT: Enter the tool nose quadrant.
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Add Grinding Stock To A Contour Line.

Use this command to add grinding stock to selected eliesoéa contour. It has provisions to remove small
corner radii from the contour so that they don't interfgith this procedure.

This script is designed to be used when the contour megylieen designed externally to Synergy or it is
necessary for drafting purposes the first draw thefigd shape. This script allows the grinding stock needed
for machining to be added without having to reconsthegeometry of the contour.

Roldled Grinding Stock

INSTRUCTIONS:

GRINDING STOCK: Thickness of stock allowance for gr inding.

MINIMUM RADIUS FOR SHARP CORNER: Input the minimum radius to be used on
corners. All radii smaller than this amount will be made into sharp
corners.

PICK AN ELEMENT OF CONTOUR: Pick an element of the contour that the stock
is to be added to.

PICK WHICH SIDE: Pick the side the stock is to be a dded.

PICK ELEMENT, Backup, Proceed: Pick all the element s which are to have the
same grinding stock.

REPLACE ORIGINAL CONTOUR Yes, No, Cancel: Y - fory es will replace the
original contour with the new contour. N - for no w ill not delete the
original but will keep the new contour. C - for can cel will delete the

new contour but leave the original unchanged.
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Introduction to Variational Design

The Variational Design Module is a powerful tool for dasig flexible part geometry. First introduced in the
mid-eighties, parametric and variational design systeave allowed engineers a new degree of freedom to
explore geometric relationships.

VDM allows programmers to build new designs that provitddture engineering changes. Manufacturing
alterations that used to take days to complete can Isbditin mere minutes. Manufacturing engineers can
design with change in mind. Nothing is "hard-coded" and therefs®mer requests can be anticipated in
advance.

For example: if a programmer uses a tapered endmilattime the wall of a component, he can assign
variables matching the taper angle. If the engineerggsathe taper angle, variational design will allow the
automatic selection of a new endmill that matchesethesy manufacturing requirements. The engineer can
build material requirements, tooling information, and gualintrol data directly into the part design. If the
customer changes the design, manufacturing data such@s@ti¥, tooling lists, fixturing layouts and quality
control all update automatically.

Another benefit is the cost and time estimation cditiglsi of variational design. Unforeseen changes or
different part sizes can dramatically affect mateeguirements and manufacturing schedules. Synergy
automatically tracks these changes and prints changsihsilso that communication between departments
remains intact. Improved communication increases a raatwer’s ability to meet delivery deadlines.

Records and Objects

Every piece of geometry created in variational desigrahasSCII data string that describes how that geometry
was created. That ASCII data-string is that geometryarde@ record contains all applicable variational
information for creating that item.

A group of records is called an object. There may beerti@n one object in a variational file. Objects are
groups of records that make up geographic representations.

Variables
There are three types of variables used in Variationabbes

Independent Variables are created with any value and are not dependent on atiggxisometry. They do
not have a variational record constraining their valieslifying an independent variable will affect all entities
whose records reference that variable.

Dependent Variables are created dependent on existing geometry. Formula, Léteytiys, Angle, Angle
Two Lines, and Dist Two pts are dependent variables. Depexdeables have variational records associated
with them.

Free Parameter s are independent numeric parameters referenced in sic@alarecord. They are the means by
which input data not specified by independent or dependent \exiedoh be later referenced or modified for
that particular record. Modifying a free parameter afiléct only the entity created by that record.
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Tools

The tool library is located inusr/weber/util/tooldata /. Each set of tools is seperated into the
following directories:
Directory Tools
tools_in inch-based milling tools
tools_mm metric milling tools
[tools_in inch-based lathe tools
[tools_mm metric milling tools

The tools are then further subdivided into categories ¢ tuased on the type of machining each tool are used
for.

Creating custom tools:

You should only ever make changes to copies of the tos! fileat way, you won’t overwrite the tool files that
came with Synergy. We suggest copying an entire tool dineand renaming it. For example, if you are going
to make custom inch-based tools, copy the entire twollirectory, and give it a custom name, like: custom_in.

Steps to create a mill tool

Chooséedit->Tool_library->Createlib tool
Pick the tool category from the selections box.
Choose a tool that's similar to the tool you wantreate.

Make changes to the data in the pop up create toolblisk. @K

o M N E

Save the changes you've made. If you haven't givetothe unique file name, Synergy will ask if you
are sure that you want to overwrite the original file.

Making Lathe Tools and their Images

Here are the instructions for creating tool imagedtfe Lathe and placing them in the proper directory.

1. In Synergy, click from the main menu: Fi#e Open-> Geometry and locate the
/usr/weber/util/tooldata/images directory.

2. Choose a tool that is similar to the one that yootuwacreate.

3. Maodify the geometry to fit your new tool.

4. Choose File> SaveAs and save it as a different name. This wijldue image name.

5. In Synergy: Choose File: Copy File and choose tagdiu just saved as the copy name.

6.1f you haven’t already, copy and rename your toolgnTinodify them accordingly. In the tool files, theltoo
image file should give the name and location of geonfigé¢rihat you copied to
"fusr/weber/util/tooldata/images/."

7. Now when you load the tool and make the Lathe imagénges that you created will be associated with
the appropriate tools.
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